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This paper presents an SPSS custom dialog (Interpreting Regression Effects) that was 

developed to access R software that helps researchers more fully understand how sets of predictor 

variables contribute to a regression model. The Interpreting Regression Effects custom 

dialog allows researchers to consider a wide variety of predictor and all-possible subset related metrics 

when interpreting regression effects including regression weights, validity coefficients, structure 

coefficients, product measures, relative important weights, all-possible-subsets regression, commonality 

coefficients, and dominance weights. 

 ultiple regression is a widely used statistical technique in the behavioral sciences (Hankins, 

French, & Horne, 2000). Researchers can use this statistical procedure in practical prediction 

problems where the goal is to forecast an outcome based on data that were collected earlier or to 

identify a minimum set of variables that yield the best prediction of the criterion for the data. In this 

procedure, the linear relationships between two or more predictor variables (also called independent 

variables) and a single criterion (also called a dependent) variable are quantified (Gall, Borg, & Gall, 

1996). The result helps identify how well predictor variables explain or predict values of a criterion 

variable. When there are high correlations among predictor variables, researchers may find it difficult to 

interpret the results and may make mistakes in their interpretations. In the presence of multicollinearity, 

even the most seasoned researcher may encounter difficulty determining how predictors work together in 

forming the regression effect.  

  For example, consider a model that helps predict employee job satisfaction. While job autonomy is 

considered a key explanatory variable of job satisfaction, researchers may include additional predictor 

variables (e.g., peer support, supervisor support, workload, pay, promotional opportunity, working 

condition, and job involvement) to increase the explanatory ability of the model. Researchers may then 

get a more powerful model but at the expense of complications in analyses and interpretation, if previous 

literature indicates there are moderate to high correlations among these additional predictor variables. The 

explained variance of employee job satisfaction may be attributable to multiple variables because of the 

interrelationships among these predictor variables and researchers may find that these variables are 

redundant in the explained variance of job satisfaction. In interpreting such a model, researchers may 

misinterpret the results if they (a) base their interpretation solely on standardized regression coefficients, 

which is justifiable only in the case that all predictors are orthogonal or uncorrelated (Courville & 

Thompson, 2001) or (b) rely on stepwise methods in selecting the best set of predictors (Nathans, Oswald 

& Nimon, 2012; Zientek & Thompson, 2006). To avoid such misinterpretation of regression models with 

correlated predictors, Kraha, Turner, Nimon, Zientek, and Henson (2012) recommended the use of 

multiple indices to interpret multiple regression effects. These indices include, but are not limited to, 

standardized regression coefficients, validity coefficients, structure coefficients, relative important 

weights, all possible subsets (APS) regression, commonality coefficients, and dominance weights. 

  The current paper presents an SPSS custom dialog (Interpreting Regression Effects) 

that was developed to access R software that helps researchers more fully understand how sets of 

predictor variables contribute to a regression model. R is a powerful programming language that works as 

an environment for statistical analysis and graphics. R procedures can be carried out using packages, 

developed by experts and statisticians, and syntax that are similar to C programming. Some researchers 

may find that R is difficult to learn if they do not have a computer programming background. With the 

Interpreting Regression Effects custom dialog, researchers and practitioners who are 

unfamiliar with R can conveniently use SPSS to perform multiple procedures for interpreting regression 

effects as those available in the yhat package (cf. Nimon & Oswald, 2013; Nimon et al, 2013).   

  The Interpreting Regression Effects custom dialog allows researchers to consider a 

wide variety of predictor and all-possible subset related metrics when interpreting regression effects. The 

following sections provide a brief overview of the indices supported by the custom dialog. For a more in-
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depth treatment of each analysis, we refer readers to Kraha et al. (2012), Nathans et al. (2012), and Nimon 

and Oswald (2013).  
 

Predictor Metrics 
 

Regression Weights 

Regression weights indicate how much each predictor contributes to the regression equation with all other 

predictors held constant. There are two kinds of regression weights: B weights (for variables in their 

unstandardized/original scale) and beta (β) weights (for variables that have been standardized). The B 

weight indicates the increase or decrease in the criterion variable for each unit of change in a given 

predictor with other predictors held constant, while a beta weight uses a standard unit (z-scores) for all 

variables. Beta weights are heavily used by researchers to assess “predictor importance,” which may be 

an ambiguous term in the presence of multicollinearity. When predictors are correlated, a variable may 

have an insignificant beta weight yet be strongly correlated to the criterion variable and predicted 

criterion variable through its relationship with other predictors. In such cases, additional measures are 

required to fully understand the effect (Nathans et al., 2012).     
 

Validity Coefficients 

 Validity coefficients are bivariate correlations between predictors and the criterion variable. When 

squared they indicate how much variance a predictor has in common with the criterion variable. Validity 

coefficients (r) are considered measures of direct effect (cf. LeBreton, Ployhart, & Ladd, 2004) as they 

assess predictor importance without considering the contribution of other predictor variables in the 

regression equation. 
 

Structure Coefficients 

  Structure coefficients (rs) are the bivariate correlation between a predictor variable and a predicted Y 

or 𝑌̂(Courville & Thompson, 2001). As with validity coefficients, structure coefficients are not affected 

by the interrelationships among the predictor variables.  When used in conjunction with beta weights, 

structure coefficients, like validity coefficients, may help identify the presence of suppression (Courville 

& Thompson; Thompson, 2006). 
 

Product Measures (Pratt’s Measures) 

  Product measures partition the regression effect into k segments, where k equals the number of 

predictor variables. The beta weight of each predictor is multiplied with its zero-order correlation with the 

criterion variable. The values that are zero or negative may be viewed as problematic to interpret. Nimon 

and Oswald (2013) recommended that researchers use this measure in addition to other coefficients (e.g., 

general dominance weights and relative weights) to more fully interpret regression effects. 
 

Relative Weights 

  Relative weights also partition the regression effect into k segments though a process that involves 

principal components analysis (Johnson, 2000). Despite differences in computational methods, relative 

weights and general dominance weights are almost always identical (LeBreton et al., 2004). Note that 

researchers may find it difficult to detect any suppression cases through these weights (Kraha et al., 

2012). 
 

All-Possible-Subsets Regression 

  This method tests all possible subsets of the set of potential predictors by conducting linear 

regressions on all 2
k 

– 1 distinct subsets.  For selection, researchers evaluate the subsets based on model 

parsimony and model fit.   
 

Commonality Coefficients 

  Commonality analysis allows researchers to identify the unique and common effects of respective 

predictor variables in explaining variance accounted for in the interested criterion variable (Rowell, 1991; 

Si, 2001). This analysis is appropriate to use when variables are highly related (Pedhazur, 1997). 

Thompson (2006) explained that commonality analysis partitions regression effects into constituent, non-

overlapping segments. Unique effects indicate how much variance is unique to a predictor variable; while 

common effects indicate how much variance is uniquely common to two or more predictors (Nimon, 
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Table 1. Correlation Matrix for Heuristic Example 

 general sentence wordc wordm 

sentence 0.717    

wordc 0.640 0.674   

wordm 0.745 0.720 0.582  

paragraph 0.658 0.733 0.582 0.704 

 

2010). While commonality coefficients provide a powerful interpretation of the regression effect 

including identifying the loci and magnitude of suppression and multicollinearity, they may be difficult to 

interpret in the presence of a large number of predictors as the number of coefficients produced is 2
k 
– 1. 

 

Dominance Weights 

  Dominance analysis is a method typically used to determine the importance of each variable based on 

pairwise comparisons of the unique variance contributions to the regression effect across all possible 

subsets of predictor variables (Nathans et al., 2012). There are three hierarchical levels of dominance 

weights: complete, conditional, and general dominance. A complete dominance analysis may help detect 

the presence of suppression (Azen & Budescu, 2003). However, as demonstrated by Nimon and Oswald 

(2013), commonality analysis may be a more reliable technique to assess the presence of suppression.  
 

Illustrative Example 

  To demonstrate the use of the SPSS custom dialog, we analyzed data from Holzinger and Swineford 

(1939). This dataset contains a total of 26 tests aimed to assess the spatial, verbal, mental speed, memory, 

and mathematical ability of 301 students from Paster High School and Grant-White High School. Four 

verbal predictors, including general information (general), sentence completion (sentence), word 

classification (wordc), and word meaning (wordm), are used to predict a criterion variable, paragraph 

comprehension (paragrap).  

  To replicate the results reported in this paper, readers can download the data set from the MBESS R 

package (Kelly & Lai, 2012) or use the SPSS syntax reported in Kraha et al. (2012) to simulate a dataset 

that corresponds to the correlation matrix reported in Table 1.   

  A standard regression analysis can then be conducted on the resulting data using the linear regression 

analysis in SPSS. The Multiple R
2
 from the regression model was .611, indicating that 61% of the 

variance in paragraph was explained by general, sentence, wordc, and wordm.  The correlation matrix in 

Table 1 indicates that the data have collinear predictors. Therefore, some of the explained variance of 

paragraph comprehension may be attributable to more than one predictor variable. The regression 

equation was:  
 

  Predicted Paragraph = 0.071 + 0.030general + 0.263sentence + 0.047wordc + 0.137wordm 
 

  To further investigate and clarify the regression 

effects, the authors can interpret multiple indices, 

including structure coefficients, all-possible-

subsets regression, commonality coefficients, 

dominance weights, and relative weights. These 

metrics will help researchers fully understand the 

contributions that these predictors make to a 

regression model and to each other. To facilitate 

ease of use and maximal understanding, further 

results are discussed separately for each of the 

seven options within the Interpreting Regression Effects custom dialog. Step by step 

instructions for both preparation and analysis are included in Appendices A and B.  
 

Calc yhat 

  The calc.yhat function produces four sets of regression metrics: Predictor Metrics (Figure 1), 

Ordered Predictor Metrics (Figure 1), Paired Dominance Metrics (Figure 1), and APS Related Metrics 

(Figure 2). The predictor metrics table provides results from several analyses, including the standard B 

and beta (β) weights and extending to validity, structure, and commonality coefficients. In the same table, 

researchers can see output from dominance analyses, Pratt’s measure, and relative weights. The ordered 

predictor metrics table provides a ranking of each predictor for each analysis. The paired dominance 

metrics table provides complete, conditional, and general dominance results for all pairwise comparisons. 

Finally, the APS related metrics table provides results from all possible subsets regression, including 

commonality, R
2
, and incremental contribution to R

2
. 

 By examining the predictor metrics in Figure 1, one sees that across all standardized predictor metrics 

(e.g., b, β, r, rs, rs
2
), the most important predictor was sentence, followed by wordm, general, and wordc.   
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Figure 1. Partial output from the calc.yhat option: Predictor, Ordered Predictor, and Paired Dominance 

Metrics. Unique = uniqueness coefficients; Common = r
2
 – Uniqueness; CD = Conditional Dominance 

Weights; GenDom = General Dominance Weights; Pratt = Pratt’s Measure; RLW = Relative Weights 
 

These findings are consistent with the results of conditional and general dominance. Results from 

conditional dominance analysis reveal that sentence conditionally dominates across all subset sizes with 

weights of .538 (CD: 0), .153 (CD: 1), .080 (CD: 2), and .054 (CD: 3). The same results can be seen in 

the general dominance metrics, as sentence generally dominates all other variables in the model. Further, 

while sentence completely dominates wordm which completely dominates general, general does not 

completely dominate wordc. This is because general adds less incremental validity than wordc when 

added to a model with wordm (.040 versus .045, see Figure 2). Also note that although the decomposition 

of the regression effect as computed by general dominance and relative weights are very similar, the 

results from Pratt’s measures are unique with more emphasis being placed on sentence and wordm and 

less emphases being placed on general and wordc. 

  By examining the commonality coefficients in Figure 2, one sees that the largest commonality 

coefficient relates to variance that is common to general, sentence, wordc, and wordm. With over 40% of 

the regression effect being attributed to variance that is common to all four predictors, one might theorize 

that the measures are tapping into a form of general intelligence or be subject to common method bias. 

From the all possible subsets regression depicted in Figure 2, researchers can see that the model with all 

four predictors yields the highest R
2
 effect size (R

2
 = .611), but the increased prediction by adding a fourth 

predictor is negligible. Two models with three (general, sentence, wordm and sentence, wordc, wordm) 

predictors have almost as much explanatory power (R
2
 = .609 and .607, respectively). In light of this 

information, researchers may opt to choose the more parsimonious or theory-driven model. 
 

All Possible Subsets 

 The all possible subsets option analyzes all possible 2
k
-1 combinations of the predictor variables, 

where k represents the number of predictors. Output from this option can be seen in Figure 3. The first 

three output tables provide information about all possible combinations that is used by the commonality 

and dominance functions. The APS matrix table provides R
2
 information for all of these subsets of size k, 

as previously discussed in the section on Calc yhat. 
 

Dominance 

 Figure 4 depicts all output from the dominance analysis. The dominance option yields three output 

tables: Complete Dominance, Conditional Dominance, and General Dominance.   
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Figure 2.  Partial output from calc.yhat – All possible subsets metrics. Includes commonality 

analysis, R
2
, and incremental R

2 
contributions 

 

Relative Weight 

 The relative weight option produces one output table displaying the relative weight for each 

predictor. As noted previously, relative weight results suggest again that sentence (RLW = .201) 

contributes the most to the model, followed by wordm (RLW =.179).  
 

Effect Size 

 The effect size option produces one table that includes six measures of effect size. Further, the 

table includes recommendations for use (yes/no) based on Yin and Fan’s (2001) exploration of multiple 

indices.  
 

Commonality 

 The commonality option produces two commonality tables: the first provides unique and common 

coefficients for all possible combinations, while the second provides unique and common coefficients for 

each individual variable. As noted previously, interpretation of these metrics reveals large amounts of 

shared variance, thus suggesting that that the measures are tapping into a form of general intelligence or 

be subject to common method bias. 
 

Bootstrap 

 The bootstrap option produces bootstrapped results for all previous analyses to help estimate the 

estimators’ properties. Confidence intervals for all predictors and all possible subset metrics are reported, 

as well as the descriptive statistics for Kendall’s tau. Users can specify the number of desired 

bootstrapped samples in the dialog box.    
 

Discussion 

   In this paper, we demonstrated the use of a custom dialog that allows SPSS users to access a set of 

functions within the yhat (Nimon et al., 2013) package in R. With the use of the Interpreting 

Regression Effects custom dialog, SPSS users can take advantage of software that has been 

developed to provide a more full interpretation of regression effects including regression weights, validity 

coefficients, structure coefficients, product measures, relative weights, all-possible-subsets regression,   
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Figure 3. Output from the All Possible Subsets dialog option. Tables marked “APS Bitmap” 

and “Predictor Bitmap” displays the various models with associated predictors, while the “APS Matrix” 

table displays the associated R
2
 for each model. 

 

commonality coefficients, and dominance weights. While SPSS syntax has been developed and published 

for each of these coefficients separately (see Kraha et al., 2012), the Interpreting Regression 

Effects custom dialog allows SPSS users to produce all of these coefficients simultaneously. In 

addition to the ease of not having to execute different sets of syntax, the solution presented in this paper 

may be useful when SPSS users desire to bootstrap their results.  

  Although we incorporated multiple functions available from the yhat package (cf. Nimon & Oswald, 

2013; Nimon et al., 2013) into the Interpreting Regression Effects custom dialog, the 

custom dialog could be developed further in order to include additional functions available in the yhat 

package, such as commonality coefficients for canonical correlation and plotting confident intervals from 

bootstrap results.   

  As has been noted elsewhere (cf. Kraha et al., 2012; Nimon et al., 2010), interpreting the relative 

contribution of predictors within a multiple regression can be a complicated and difficult process, 

particularly in the presence of multicollinearity (Stevens, 2009). We advise that researchers utilizing 

SPSS for multiple linear regression analyses consider using the Interpreting Regression 

Effects custom dialog so that they may have a more full interpretation of the regression effect than is 

offered in the standard SPSS output.   
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Figure 4.  Output from the Dominance option, where .inc represents the incremental contribution to 

R
2
.and CD: 0 represents average additional contribution when the subset size i 
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APPENDIX A 

Software Preparation Steps 

Steps to prepare R for analyses: 
Step One: Install R version 2.15.2 from http://cran.r-project.org/bin/windows/base/old/2.15.2/  

Step Two: Run R-2.15.2-win.exe and follow command prompts  

Step Three: Download R packages. This process is required only during the setup.  You are not 

required to open the R program in order to use the SPSS custom dialog box in the future. 

1. Open R 

2. On the menu bar, select Packages, select Install package(s)… 

http://cran.r-project.org/web/packages/yhat/index.html
mailto:Knimon@uttyler.edu
http://cran.r-project.org/bin/windows/base/old/2.15.2/
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Step Four: The packages window appears. Select boot, foreign, and yhat. Holding CTRL will 

allow you to select more than one package at a time. Click OK. 

 
Step Five: Once packages have been successfully installed, close R.  

 

Steps to prepare SPSS with R Essentials add-on: 

 

Step One: If you are unsure of your SPSS version, you can check by selecting from the SPSS menu bar, 

Help -> About. You will need this information in Step 3d below.  
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Step Two: To determine if you system is 32- or 64-bit (Windows), go to start and right click My 

Computer. Choose properties, and look for “System type” under System. You will need this information 

in Step 3f below. 

 

Step Three: Download R Essentials from IBM.  

1. Go to http://www.ibm.com/developerworks/spssdevcentral   

2. Follow the link to “Download materials for IBM SPSS Statistics” 

3. Scroll down to subheading “R Essentials” and click the link to download “The Essentials for R 

for Statistics versions 19 and later” 

a. You will be prompted to log in or create a free account.  

4. Select the version of Essentials for R that matches your SPSS version and click continue (if you 

don’t know your SPSS version, see Step One above). 

 

5. Select notification preferences, agree to license agreements, and click “I confirm” 

6. Select the “Download using http” tab, then scroll down and choose the correct install for your 

system (keeping in mind operating system and 32- or 64-bit systems; if you don’t know your 

operating system type, see Step Two above) 

 

Step Four: Run SPSS_Statistics_REssentials[…].exe. Double click the file and follow command 

prompts. For certain system set ups, you may need to run this file as an administrator. To do so, right-

click the downloaded file and select “Run as administrator.” 

 

Steps to prepare SPSS with Custom Dialog: 

 

Step One: Download the custom dialog file (Interpreting Regression Effects.spd) from 

https://goo.gl/jDJZ9y 

 

Step Two: Install Interpreting Regression Effects.spd 

1. Option One: Double click the downloaded file. A new window from SPSS will appear. 

Select install. The custom dialog will be permanently installed in a specified SPSS menu  

 
2. Option Two: Alternatively, you can install the .spd file through the installation menu in 

SPSS.  This procedure requires administrative access to your computer and you will have to run 

SPSS as an administrator. If your computer is owned by the university or your work place, you 

may have to contact a technical support person to give you an administrative access.  

a. On the SPSS menu bar, select Utilities -> Custom Dialogs -> Install Custom Dialog.  

 

b. When the window opens, select the downloaded .spd file, click Open. 

c. Upon successful installation, you will receive a notification stating where the file was 

installed.  

http://www.ibm.com/developerworks/spssdevcentral
https://www.ibm.com/developerworks/community/wikis/home?lang=en#/wiki/We70df3195ec8_4f95_9773_42e448fa9029/page/Downloads%20for%20IBM%C2%AE%20SPSS%C2%AE%20Statisticshttps://www.ibm.com/developerworks/community/wikis/home?lang=en
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Note: Once you have completed the preparatory steps above, you will be ready to analyze data. Please 

note that you will only have to complete the steps above once—after the files are installed, you will be 

ready to start with data analysis each time.  

 

APPENDIX B 

Steps to Replicate Illustrative Sample 

Step One: Open SPSS in administrator mode. To run the programs as an administrator, right-click on the 

program icons, select “Run as administrator.” 

 
Step Two: Open Holzinger and Swineford (1939) data file in SPSS, select File > Open > Data. The data 

can be found in the MBESS R Package (Kelly & Lai, 2012) or by using syntax from Kraha et al. (2012).  

Step Three: In SPSS, select Analyze > Regression > Interpreting Regression Effects 

 
Step Four: The dialog box opens. Click on the criterion variable (i.e., paragraph), then the top right 

arrow to put the variable into the Dependent box. Click the predictor variables (i.e., general, sentence, 

wordc, wordm), then the bottom right arrow to put the variables into the Independents box. 
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Step Five: Select one of the analysis options from a drop-down menu (i.e., calc.yhat). Click OK to 

run. The SPSS dataset and output viewer will be processed by R and the output will appear in the SPSS 

viewer.  

 
 


